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Printable PDF Vector Map Croatia, exact extra detailed Country Plan Roads full editable Adobe PDF in layers, scalable, 226 mb ZIP

All roads, cities, towns, villages, hamlets, airports. Map for design, printing, arts, projects, presentations, for architects, designers and builders, business, logistics.

Layers: Ground, green-1, green-2, Water_objects, Water_objects, Waterways,  RailRoads, Streets_roads, Points_Cities, Names_Cities, Points_main_cities_airports, Names_1, Names_2, Grids, Legend, etc.

The most exact and detailed map of Croatia.

For High Quality Printing 


SKU: 2018.15.06.CRO.RM.FU.PDF

Share this map for your friends!










Taxonomy: Product Tags for this Vector Map



AutoCAD Map Croatia full, City Map Croatia full, City Plan Croatia full, CorelDraw Map Croatia full, Croatia full City Vector Map, Croatia full Map, DWG Map Croatia full, DXF Map Croatia full, Editable Map Croatia full, Illustrator Map Croatia full, Map Croatia full for Printing, PDF Map Croatia full, printable map Croatia full, Road Map Croatia full, Street Map Croatia full, Tourist Map Croatia full, Urban Plan Croatia full, Vector Map Croatia full

Map Categories



Countries full vector maps: PDF and Adobe Illustrator, Croatia Vector Maps Adobe Illustrator, PDF, CDR, Europe maps

Extended Description of the Vector Map



Printable PDF Vector Map Croatia, exact extra detailed Country Plan Roads full editable Adobe PDF in layers, scalable, 226 mb ZIP

All roads, cities, towns, villages, hamlets, airports. Map for design, printing, arts, projects, presentations, for architects, designers and builders, business, logistics.

Layers: Ground, green-1, green-2, Water_objects, Water_objects, Waterways,  RailRoads, Streets_roads, Points_Cities, Names_Cities, Points_main_cities_airports, Names_1, Names_2, Grids, Legend, etc.

The most exact and detailed map of Croatia.

For High Quality Printing 

DWG, DXF, CDR, ESRI Shapes, and other formats – by request, same price, please contact.

 

Croatia.

This vector map of Croatia is used as a basis for design, editing, and further printing.

This is the most detailed, exact map of Croatia for high-quality printing and polygraphy. You can always clarify the map development date by contacting us.

For your convenience, all objects on Croatia vector map are divided into layers. And the editing is very easy – colors, lines, etc.

You can easily add any objects needed (e.g. shops, salons, sale points, gas station or attraction) on any layer of Croatia vector map.

One of the advantages of Croatia vector maps of our production is the relevance of cartographic data, we constantly update all our products.

Croatia is a country at the crossroads of Central and Southeast Europe, on the Adriatic Sea. Its capital Zagreb forms one of the country’s primary subdivisions, along with twenty counties. Croatia has an area of 56,594 square kilometres (21,851 square miles) and a population of 4.28 million, most of whom are Roman Catholics.



This vector map of Croatia is used by:

designers, layout designers, printers, advertisers and architects. Our product – vector maps – is designed for further editing and printing in large formats – from @Wall format (a few meters) to A-0 and A-1, A-2, A-3.

The Croatia map in vector format is used for design, urban planning, presentations and media visualizations.

The Croats arrived in the area in the 6th century and organised the territory into two duchies by the 9th century. Tomislav became the first king by 925, elevating Croatia to the status of a kingdom, which retained its sovereignty for nearly two centuries, reaching its peak during the rule of kings Petar Krešimir IV and Dmitar Zvonimir.



The advertising and presentation map of Croatia (usually the final designer marks the routes, and puts the client’s objects (shops, saloons, gas stations etc.)

The undoubted advantage is that people will NEVER throw out this advertising product – the map. In fact, as an advertising medium, a map is the most “long-playing” of the well-known polygraphic advertising media, with the longest lifespan, and the maximum number of interactions with the customer.

For travelers, maps are sold at the airports and gas stations around the world. Often the source is our vector maps.

Croatia entered a personal union with Hungary in 1102. In 1527, faced with Ottoman conquest, the Croatian Parliament elected Ferdinand I of Austria to the Croatian throne. In October 1918, in the final days of World War I, the State of Slovenes, Croats and Serbs, independent from Austria-Hungary, was proclaimed in Zagreb, and in December 1918 it was merged into the Kingdom of Serbs, Croats and Slovenes. Following the Axis invasion of Yugoslavia in April 1941, most of the Croatian territory was incorporated into the Nazi-backed client-state which led to the development of a resistance movement and the creation of the Federal State of Croatia which after the war become a founding member and a federal constituent of the Socialist Federal Republic of Yugoslavia.



Take a look, who purchases our vector maps of Croatia in “Our Clients and Friends” page – these are large and small companies, from super-brands like Volvo and Starbucks, to small design studios and printing houses.

It’s very easy to work with vector maps of Croatia city, even for a not very experienced designer who can turn on and off the map layers, add new objects, change the colors of fill and lines according to customer requirements.

On 25 June 1991, Croatia declared independence, which came wholly into effect on 8 October of the same year. The Croatian War of Independence was fought successfully for four years following the declaration.

The sovereign state of Croatia is a republic governed under a parliamentary system and a developed country with a very high standard of living. It is a member of the European Union (EU), the United Nations (UN), the Council of Europe, NATO, the World Trade Organization (WTO), and a founding member of the Union for the Mediterranean.



The undoubted advantage of Croatia vector maps in printing is an excellent and detailed visualization, when customer can expand a large paper map and instantly define his location, find a landmark, an object or address on map, unlike using the popular electronic formats of Google and Yandex maps for example.

Printable vector maps of Croatia are much more convenient and efficient than any electronic maps on your smartphone, because ALL DETAILS are displayed in the entire space of Croatia map.

As an active participant in the UN peacekeeping forces, Croatia has contributed troops to the NATO-led mission in Afghanistan and took a non-permanent seat on the UN Security Council for the 2008–2009 term. Since 2000, the Croatian government has constantly invested in infrastructure, especially transport routes and facilities along the Pan-European corridors.



Useful tips on working with vector maps of cities and countries in Adobe Illustrator.

«V» – launches the Selection tool (cursor, black arrow), which makes active any vector line.

«А» – launches the Direct Selection tool (white cursor), allows you to select curve elements and drag them to the desired place.

«R» – activates the Rotate tool, which helps you rotating selected objects around the center point by 360 degrees.

«E» – gives you the opportunity to use the Eraser tool and erase unnecessary parts.

«X» – switches between Fill and Stroke in the Tools section. Try to get used to this hot key and

you will quickly understand that you can’t live and work without it.

Croatia’s economy is dominated by service and industrial sectors and agriculture. Tourism is a significant source of revenue, with Croatia ranked among top 20 most popular tourist destinations in the world. The state controls a part of the economy, with substantial government expenditure. The European Union is Croatia’s most important trading partner. Croatia provides a social security, universal health care system, and a tuition-free primary and secondary education, while supporting culture through numerous public institutions and corporate investments in media and publishing.



Guides are not limited to vertical and horizontal in Adobe Illustrator. You can also create a diagonal guide for example. Moreover, you can turn any contours into guides. Select the outline and go to View > Guides > Make Guides (Create Guides), or simply press Cmd/Ctrl + 5. You can also turn the guides back into an editable object. Go to menu, View > Guides > Unlock Guides (Release Guides), select the guide you want to edit and select View > Guides > Release Guides (Reset Guides), or just press Cmd/Ctrl + Option / Alt + 5).

Geography of Croatia

The Geography of Croatia is defined by its location—it is described as a part of Central Europe and Southeast Europe, a part of the Balkans and Mitteleuropa. Croatia’s territory covers 56,594 km2 (21,851 sq mi), making it the 127th largest country in the world. Bordered by Bosnia and Herzegovina and Serbia in the east, Slovenia in the west, Hungary in the north and Montenegro and the Adriatic Sea in the south, it lies mostly between latitudes 42° and 47° N and longitudes 13° and 20° E. Croatia’s territorial waters encompass 18,981 square kilometres (7,329 sq mi) in a 12 nautical miles (22 km; 14 mi) wide zone, and its internal waters located within the baseline cover an additional 12,498 square kilometres (4,826 sq mi).



You will probably want to change the color scheme used on our Croatia vector map.

To quickly and effectively play with colors.

Of course, you can do it manually, all objects in our Croatia vector map are divided according to types and layers, and you can easily change the color gamma of vector objects in groups and layers.

The Pannonian Basin and the Dinaric Alps, along with the Adriatic Basin, represent major geomorphological parts of Croatia. Lowlands make up the bulk of Croatia, with elevations of less than 200 metres (660 ft) above sea level recorded in 53.42% of the country. Most of the lowlands are found in the northern regions, especially in Slavonia, itself a part of the Pannonian Basin plain. The plains are interspersed with horst and graben structures, believed to have broken the Pliocene Pannonian Sea’s surface as islands.



But there is more effective way of working with the whole VECTOR MAP of Croatia and all layers:

The overview dialog «Edit colors»/«Repaint Graphic Object» (this dialog box name can change depending on the context):

If you have selected a part or a layer of Croatia vector map and open the dialog box by clicking the icon in the Control panel, on the Samples palette or the Color Catalog, or if you choose Edit > Edit Colors> Repaint Graphic Object, then the «Repaint Graphic Object» dialog box appears, and you get access to «Assign» and «Edit» tabs.

The greatest concentration of ground at relatively high elevations is found in the Lika and Gorski Kotar areas in the Dinaric Alps, but high areas are found in all regions of Croatia to some extent. The Dinaric Alps contain the highest mountain in Croatia—1,831-metre (6,007 ft) Dinara—as well as all other mountains in Croatia higher than 1,500 metres (4,900 ft). Croatia’s Adriatic Sea mainland coast is 1,777.3 kilometres (1,104.4 mi) long, while its 1,246 islands and islets encompass a further 4,058 kilometres (2,522 mi) of coastline—the most indented coastline in the Mediterranean. Karst topography makes up about half of Croatia and is especially prominent in the Dinaric Alps, as well as throughout the coastal areas and the islands.



If a picture or a map fragment is not selected, and you open the dialog box by clicking the icon in the Control panel, on the Samples palette or in the Color Catalog, the «Edit Colors» dialog box appears and you can only access the «Edit» tab.

Regardless of the name at the top of the dialog box, the right-hand side always displays the color group of the current document, as well as two default color groups: Print Color and Grayscale. These color groups can be selected and used any time.

62% of Croatia’s territory is encompassed by the Black Sea drainage basin. The area includes the largest rivers flowing in the country: the Danube, Sava, Drava, Mur and Kupa. The remainder belongs to the Adriatic Sea drainage basin, where the largest river by far is the Neretva. Most of Croatia has a moderately warm and rainy continental climate as defined by the Köppen climate classification. The mean monthly temperature ranges between −3 °C (27 °F) and 18 °C (64 °F).



Create and edit color groups of Croatia vector map, and also assign colors using the «Edit Colors»/ а «Repaint Graphic Object» dialog box.

A. Creating and editing of a color group on the «Edit» tab

B. Assigning colors on the «Assign» tab

C. Select a group of colors from the «Color groups» list

The option «Repaint a graphic object» in the lower part of the dialog box allows you to preview the colors on a selected layer of Vector map, or a group of elements, and specify whether its colors will be redefined when the dialog box is closed.

Croatia has a number of ecoregions because of its climate and geomorphology, and the country is consequently among the most biodiverse in Europe. There are four types of biogeographical regions in Croatia: Mediterranean along the coast and in its immediate hinterland; Alpine in the elevated Lika and Gorski Kotar; Pannonian along the Drava and Danube; and Continental in the remaining areas. There are 444 protected natural areas in Croatia, encompassing 8.5% of the country; there are about 37,000 known species in Croatia, and the total number of species is estimated to be between 50,000 and 100,000.



The main areas of the dialog box are:

«Edit»

The «Edit» tab is designed to create a new or edit the existing color groups.

The harmony rules Menu and the Color Wheel are used to conduct experiments with color harmonies. The color wheel shows how colors are related in color harmony, and the color bars allow you to view and manipulate an individual color values. In addition, you can adjust the brightness, add and remove colors, save color groups and view colors on the selected Vector Map of Croatia or a separated layers.

The permanent population of Croatia by the 2011 census reached 4.29 million. The population density was 75.8 inhabitants per square kilometre, and the overall life expectancy in Croatia at birth was 75.7 years.



«Assign»

The «Assign» tab is used to view and control on how the original colors are replaced with colors from the color group like your corporate colors in the Vector Map of Croatia city.

The assign color ability is provided only if the entire map, layer or fragment is selected in the document. You can specify which of new colors replace the current colors, whether the spot colors should be preserved and how colors are replaced (for example, you can replace colors completely or changing the color tone while maintaining the brightness). The «Assign» tab allows you to redefine colors in the Vector Map of Croatia city, or in separate layers and fragments using the current color group or reducing the number of colors in the current Vector Map.

The country is inhabited mostly by Croats (89.6%), while minorities include Serbs (4.5%), and 21 other ethnicities (less than 1% each) recognised by the constitution. Since the counties were re-established in 1992, Croatia is divided into 20 counties and the capital city of Zagreb. The counties subdivide into 127 cities and 429 municipalities. The average urbanisation rate in Croatia stands at 56%, with a growing urban population and shrinking rural population. The largest city and the nation’s capital is Zagreb, with an urban population of 686,568 in the city itself and a metropolitan area population of 978,161. The populations of Split and Rijeka exceed 100,000, and five more cities in Croatia have



Color groups

Is a list of all saved color groups for current document (the same groups appear in the «Samples» palette). You can edit and delete the existing color groups, as well as creating a new ones using the list of “Color Groups” in the dialog box. All changes appear in the «Samples» palette.

The highlighted color group shows, which color group is currently edited.

Any color group can be selected and edited, or used to redefine the colors in the selected vector map of Croatia city, its fragments or elements.

Area and borders

Croatia’s territory covers 56,594 square kilometres (21,851 square miles), making it the 127th largest country in the world. The physical geography of Croatia is defined by its location—it is described as a part of Southeast Europe Croatia borders Bosnia–Herzegovina (for 1,009.1 km) and Serbia (for 317.6 km) in the east, Slovenia for 667.8 km in the west, Hungary for 355.5 km in the north and Montenegro for 22.6 km and the Adriatic Sea in the south. It lies mostly between latitudes 42° and 47° N and longitudes 13° and 20° E. Part of the extreme south of Croatia is separated from the rest of the mainland by a short coastline strip around Neum belonging to Bosnia–Herzegovina.



Saving a color group adds this group to the specified list.

Opening the «Edit Colors»/«Repaint Graphic Object» dialog box.

Open the «Edit Colors»/«Repaint Graphic Object» dialog box using one of the following methods:

«Edit»> «Edit Colors»> «Repaint Graphic object» or «Repaint With Style».

Use these commands if you need to edit the colors in the selected vector map of Croatia city.

«Repaint Graphic object» button on the «Control» panel.

Use this button if you need to adjust colors of Croatia vector map using the а «Repaint graphic object» dialog box.

Croatia’s 348-kilometre (216 mi) border with Hungary was inherited from Yugoslavia. Much of the border with Hungary follows the Drava River or its former river bed; that part of the border dates from the Middle Ages. The border in Međimurje and Baranya was defined as a border between the Kingdom of Hungary and the Kingdom of Serbs, Croats, and Slovenes, later renamed the Kingdom of Yugoslavia, pursuant to the Treaty of Trianon of 1920.



The specified button is available if the selected vector map or its fragment contains two or more colors.

Note. This color editing method is convenient for global color adjustment in a vector map, if global colors were not used when creating a Map of Croatia.

The «Edit colors» button or «Edit or apply colors» on the «Color Catalog» palette

Click this button if you need to edit colors on the «Color Catalog» palette or edit and then apply them to the selected Vector Map of Croatia or its fragment.

The present outline of the 956-kilometre (594 mi) border with Bosnia–Herzegovina and 19-kilometre (12 mi) border with Montenegro is largely the result of the Ottoman conquest and subsequent recapture of territories in the Great Turkish War of 1667–1698 formally ending with the Treaty of Karlowitz, as well as the Fifth and Seventh Ottoman–Venetian Wars. This border had minor modifications in 1947 when all borders of the former Yugoslav constituent republics were defined by demarcation commissions implementing the AVNOJ decisions of 1943 and 1945 regarding the federal organisation of Yugoslavia. The commissions also defined Baranya and Međimurje as Croatian territories, and moreover set up the present-day 314-kilometre (195 mi) border between Serbia and Croatia in Syrmia and along the Danube River between Ilok and the Drava river’s mouth and further north to the Hungarian border; the Ilok/Drava section matched the border between the Kingdom of Croatia-Slavonia and Bács-Bodrog County that existed until 1918 (the end of World War I).



The «Edit color group» button or «Edit or apply color group» on the «Samples» palette.

Click this button if you need to edit the colors in the specific color group or edit and apply them to the selected Vector Map of Croatia or a group of its elements, for example, the whole layer “Streets and lines”. You can also double-click the color group in the Samples panel to open the dialog box.

Most of the 600-kilometre (370 mi) border with Slovenia was also defined by the commissions, matching the northwestern border of the Kingdom of Croatia-Slavonia, and establishing a new section of Croatian border north of the Istrian peninsula according to the ethnic composition of the territory previously belonging to the Kingdom of Italy.



If the map file is too large and your computer freezes or even can’t open it quickly:

1. Try to reduce the color resolution of the video card (display) to 256 colors while working with a large map.

2. Using Windows Task Manager, select all the application you don’t need, while working with map, just turn them off.

3. Launch Adobe Illustrator. (DO NOT OPEN the vector map file)

4. Start the Windows Task Manager using administrator rights > Find the “Illustrator” process > set the «real time» priority,

5. Open the file. When you see the LEGACY FONT popup window – click “OK” (do not update). You can restore the TEXT later.

6. Can also be useful: When file is opened – Edit > Settings > Basic Settings > disable smoothing. /// It looks scary, but works quickly)))

We recommend saving the file in Adobe Illustrator 10 version. It’s much more stable when working with VERY BIG size files.

Pursuant to the 1947 Treaty of Peace with Italy the islands of Cres, Lastovo and Palagruža and the cities of Zadar and Rijeka and most of Istria went to communist Yugoslavia and Croatia, while carving out the Free Territory of Trieste (FTT) as a city-state. The FTT was partitioned in 1954 as Trieste itself and the area to the north of it were placed under Italian control, and the rest under Yugoslav control. The arrangement was made permanent by the Treaty of Osimo in 1975. The former FTT’s Yugoslav part was partitioned between Croatia and Slovenia, largely conforming to the area population’s ethnic composition.

In the late 19th century, Austria-Hungary established a geodetic network, for which the elevation benchmark was determined by the Adriatic Sea’s average level at the Sartorio pier in Trieste. This benchmark was subsequently retained by Austria, adopted by Yugoslavia, and kept by the states that emerged after its dissolution, including Croatia.

Extreme points

The geographical extreme points of Croatia are Žabnik in Međimurje County as the northernmost point, Rađevac near Ilok in Vukovar-Syrmia County as the easternmost point, Cape Lako near Bašanija in Istria County as the westernmost point and the islet of Galijula in Palagruža archipelago in Split-Dalmatia County as the southernmost point. On the mainland, Cape Oštra of the Prevlaka peninsula in Dubrovnik-Neretva County is the southernmost point.

Maritime claims

Map with water in the center

Italy and Yugoslavia defined their delineation of the continental shelf in the Adriatic Sea in 1968, with an additional agreement on the boundary in the Gulf of Trieste signed in 1975 in accordance with the Treaty of Osimo. All the successor states of former Yugoslavia accepted the agreements. Prior to Yugoslavia’s breakup, Albania, Italy and Yugoslavia initially proclaimed 15-nautical-mile (28 km; 17 mi) territorial waters, subsequently reduced to the international-standard 12 nautical miles (22 km; 14 mi); all sides adopted baseline systems. Croatia also declared its Ecological and Fisheries Protection Zone (ZERP)—a part of its Exclusive Economic Zone—as extending to the continental shelf boundary. Croatia’s territorial waters encompass 18,981 square kilometres (7,329 sq mi); its internal waters located within the baseline cover an additional 12,498 square kilometres (4,826 sq mi).

Topography

Most of Croatia is lowlands, with elevations of less than 200 metres (660 ft) above sea level recorded in 53.42% of the country. Most of the lowlands are found in the country’s northern regions, especially in Slavonia, representing a part of the Pannonian Basin. Areas with elevations of 200 to 500 metres (660 to 1,640 ft) above sea level encompass 25.61% of Croatia’s territory, and the areas between 500 and 1,000 metres (1,600 and 3,300 ft) above sea level cover 17.11% of the country. A further 3.71% of the land is 1,000 to 1,500 metres (3,300 to 4,900 ft) above sea level, and only 0.15% of Croatia’s territory is elevated greater than 1,500 metres (4,900 ft) above sea level. The greatest concentration of ground at relatively high elevations is found in the Lika and Gorski Kotar areas in the Dinaric Alps, but such areas are found in all regions of Croatia to some extent. The Pannonian Basin and the Dinaric Alps, along with the Adriatic Basin, represent major geomorphological parts of Croatia.

Topography of Croatia is defined through three major geomorphological parts of the country. Those are the Pannonian Basin, the Dinaric Alps, and the Adriatic Basin. The largest part of Croatia consists of lowlands, with elevations of less than 200 metres (660 feet) above sea level recorded in 53.42% of the country. Bulk of the lowlands are found in the northern regions of the country, especially in Slavonia, itself a part of the Pannonian Basin plain. The plains are interspersed by the horst and graben structures, believed to break the Pannonian Sea surface as islands. The greatest concentration of ground at relatively high elevations is found in Lika and Gorski Kotar areas in the Dinaric Alps, but such areas are found in all regions of Croatia to some extent. The Dinaric Alps contain the highest mountain in Croatia—1,831-metre (6,007 ft) Dinara, as well as all other mountains in Croatia higher than 1,500 metres (4,900 feet). Croatia’s Adriatic Sea mainland coast is 1,777.3 kilometres (1,104.4 miles) long, while its 1,246 islands and islets encompass further 4,058 kilometres (2,522 miles) of coastline—the most indented coastline in the Mediterranean. Karst topography makes up about half of Croatia and is especially prominent in the Dinaric Alps, as well as throughout the coastal areas and the islands.

 

Croatia

Croatia officially the Republic of Croatia (Croatian: Republika Hrvatska), is a country at the crossroads of Central and Southeast Europe, on the Adriatic Sea. Its capital Zagreb forms one of the country’s primary subdivisions, along with twenty counties. Croatia has an area of 56,594 square kilometres (21,851 square miles) and a population of 4.28 million, most of whom are Roman Catholics.

Area

• Total 56,594 km2 (21,851 sq mi)

• Water (%) 1.09

Population

• 2017 estimate 4,154,200

• 2011 census 4,284,889

• Density 75.8/km2 (196.3/sq mi)

Free vector maps:



Free download printable map Europe vector Adobe Illustrator >>>

Free download printable PDF map Europe vector Adobe PDF >>>  


Author: Kirill Shrayber, Ph.D.

I have been working with vector cartography for over 25 years, including GPS, GIS, Adobe Illustrator and other professional cartographic software.

Linkedin: https://www.linkedin.com/in/kirill-shrayber-0b839325/

Twitter: https://twitter.com/vectormapper








See more maps of this city / area / state / country
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US: US: SOLCITY NAV, LLC

651 N Broad St Suite 201

Middletown, DE US

+1(786) 292-6893 



Tel. Whatsapp: +1.829.4100078
Restauracion 261, Santo Domingo, Distrito Nacional, 11903
vectormapper@gmail.com
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